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ESP8266 Web Server with Arduino IDE

Hello and thank you for downloading this project eBook!

This quick eBook is my step-by-step guide designed to help you build a web
server with the WiFi module called ESP8266.

About the ESP8266

The ESP8266 is a $4 (up to $10) Wi-Fi module. It allows you to control

inputs and outputs as you would do with an Arduino, but it comes with Wi-Fi.

So, it is great for home automation/internet of things applications.
So what can you do with this low cost module?

You can create a web server, send HTTP requests, control outputs, read
inputs and interrupts, send emails, post tweets, build IoT gadgets and much

more.

ESP8266 specifications

e 802.11 b/g/n protocol

e Wi-Fi Direct (P2P), soft-AP

e Integrated TCP/IP protocol stack
e Built-in low-power 32-bit CPU

e SDIO 2.0, SPI, UART
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Finding Your ESP8266

The ESP8266 comes in a wide variety of versions. The ESP-12E or often

called ESP-12E NodeMCU Kit is currently the most practical version and
that’s the module we’ll be using most throughout this project. You can find
this ESP8266 board on the following link:

e htips://makeradvisor.com/tools/esp8266-esp-12e-nodemcu-wi-fi-

development-board/

This project was tested with ESP-01, ESP-07, ESP-12 and ESP-12E. So you

can follow this project guide with any of those boards.

I highly recommend using the ESP8266-12E NodeMCU Kit, the one that has
built-in programmer. The built-in programmer makes it easy to prototype

and upload your programs.
You may also find useful taking a look at the following article:

e Best ESP8266 Wi-Fi Development Board — Buying Guide
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ESP-12E NodeMCU Kit Pinout

Here’s a quick overview of the ESP-12E NodeMCU Kit pinout:
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D8(GPIO16) can only be used as gpioc read/write, no interrupt supported, no pwm/i2c/ow supported.
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ESP8266 with Arduino IDE

In this section you're going to download, install and prepare your Arduino
IDE to work with the ESP8266. You can program your ESP8266 using the

friendly Arduino programming language.

What's the Arduino IDE?

The Arduino IDE is an open-source software that makes it easy to write code

and upload it to the Arduino board. This GitHub repository added support
for the ESP8266 board to integrate with the Arduino IDE.

The Arduino IDE is a multiplatform software, which means that it runs on

Windows, Mac OS X or Linux (it was created in JAVA).

Requirements

You need to have JAVA installed in your computer. If you don’t have, go to

this website: http://java.com/download, download and install the latest

version.

Downloading Arduino IDE

To download the Arduino IDE, visit the following URL:

https://www.arduino.cc/en/Main/Software.

Then, select your operating system and download the software (as shown

below).
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W +lolvi-]
Genuino

ARDUINO

Home Buy Download Products -~ Learning « Forum Support - LOG IN SICN UP

Download the Arduino Software

Windows installer
Windows zIP file for non admin install

ARDUINO 1.8.0 Windows app| Get [:

The open-scurce Arduine Software (IDE) makes it easy to

write code and upload it to the board. It runs on Mﬂc os X10.7 Lion or newer
Windows, Mac OS5 X, and Linux. The environment is

% written in Java and based on Processu'lgmc other open- .
e Linux 32 bits

This software can be used with any Arduino board. Linux 64 bits
Refer to the Getting Started page for Installation Linux ARM
instructions.

Release Notes
Source Code
Checksums (sha512)

Installing Arduino IDE

Grab the file you’ve just downloaded named “arduino-(...).zip”. Run that file

and follow the installation wizard that shows on your screen. Open the

Arduino IDE application file (see figure below).

Mame Date medified Type Size

dist 13/08/2015 20:33 File folder

drivers 13/08/2015 20:53 File folder

examples 13/08/2015 20:54 File folder

hardware 13/08/2015 20:54 File folder

java 13/08/2015 20:57 File folder

lib 13/08/2015 20:39 File folder

libraries 13,/08/2015 21:00 File folder

reference 13/08/2015 21:03 File folder

tools 13/08/2015 21:03 File folder
arduino 14/08/2015 17:42 Application 393 KB
B arduino.ldj 13/08/2015 20:53 Configuration sett... 1KB
@ arduine_debug 13/08/2015 20:33 Application 390 KB
B arduine_debug.l4j 13/08/2015 20:53 Configuration sett... TKB
libusbO.dll 13/08/2015 20:53 Application extens... 43 KB
msvep100.dll 13/08/2015 20:53 Application extens.., 42 KB
msver100.dll 13/08/2015 20:53 Application extens... 753 KB
D revisions 13/08/2015 20:53 Text Document 66 KB
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When the Arduino IDE first opens, this is what you should see:

sketch_aug22a | Arduine 1.6.5 - O ¥
File Edit Sketch Tools Help

sketch_aug22a

P:id setup() { L
// put your setup code here, to run once:

}

vold loop() {
S/ put your main code here, to run repeatedly:

Arduing Uno on CORG

Installing ESP8266 Board

To install the ESP8266 board in your Arduino IDE, follow these next

instructions:

1. Open the preferences window from the Arduino IDE. Go to File »
Preferences

2. Enter http://arduino.esp8266.com/stable/package esp8266com in

dex.json into Additional Board Manager URL:s field and press the
“OK” button
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Preferences *

Sketchbook location:

C:Wsers\Rui Santos\Documents VArduing Browse

Editor language: | System Default ~ | (requires restart of Arduino)

Editor font size: |12
Show verbose output during: [ | compilation  [] upload

Compiler warnings: Mone  «

[] visplay line numbers

[] Enable Code Folding

Verify code after upload

[[] use external editor

Chedk for updates on startup

Update sketch files to new extension on save (.pde -> .ino)
Save when verifying or uploading

Additional Boards Manager URLs: http:ffarduinn.espB266.comfstable,.’pa‘iage_espS266c0m_index.json| ﬁ

More preferences can be edited directly in the file

C:\sers\Rui Santos\AppData\RoamingArduino 15\preferences. txt

(edit only when Arauing is not running

OK Cancel
3. GotoTools » Board » Boards Manager...
sketch_aug22a | Arduing 1.65 - | X
File Edit Sketch Tools Help
Auto Format Cirl+T m
Archive Sketch
sketeh_auglz: Fix Encoding & Reload u
void setup() Serial Monitor Ctrl+ Shift+M "
// put your
Board: "Arduino Uno" I Boards Manager... I
! Port Arduino AVR Boards
woid loop() { Programmer: "AVRISP mkll" 3 BT T
/1 put yous Burn Bootloader _ | i U
Arduine Duemilanove or Diecimila
! Arduinc Nano
Arduinc Mega or Mega 2360
Arduinc Mega ADK
Arduino Leonardo
Arduino Micro
Arduino Esplora
Arduino Mini =
Arduino Ethernet
Arduine Fio
Arduino BT

LilyPad Arduine USE
LilyPad Arduine
Arduino Pro or Pro Mini

Arduino NG or older

Arduino Robot Control
Arduino Robot Motor

Arduinc Gemma
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4. Scroll down, select the ESP8266 board menu and Install “esp8266 by
ESP8266 Community”

Edison.
More info

AMEL-Tech Boards by AMEL Technology
Boards included in this package:
SmartEverything Fosx.

Cnline help
More info

aesp8266 by ESP8266 Community
Boards included in this package:
Generic ESPE8266 Module, Climex MOD-WIFI-ESPE266(-DEV), NodeMCU 0.9 (ESP-12 Module), NodeMCU 1.0 (ESP-12E Module), Adafruit HUZZAH

ESP8266 (ESP-12), SweetPea ESP-210.
i

5. GotoTools » Board » NodeMCU 1.0 (ESP-12E Module)

More info

Tools Help
! Auto Format Ctrl+T
| Acchive Sketch
1 Fix Encoding & Reload
Serial Monitor Ctrl+Shift+ M
Serial Plotter Ctrl+Shift+L

WiFi101 Firmware Updater

Board: "NodeMCU 1.0 (ESP-12E Module)" ] F

CPU Frequency: "80 MHz" b LilyPad Arduino

Flash Size: "4M (3M SPIFFS)" 3 Arduino Pro or Pro Mini
Upload Speed: "115200" b Arduino NG or older
Port Arduino Robot Control

Get Board Info Arduino Robot Motor

Arduino Gemma
Programmer: "AVRISP mkl" 1 EsP3z Arduino
ESP32 Dev Module
Electronic SweetPeas - ESP320
MNano32
WEMOS LoLin32

ESPea32

Burn Bootloader

MNeduino Quantum
MNode3Zs

ESP8266 Modules

Generic ESPE266 Module
Generic ESP8285 Module
ESPDuino (ESP-13 Module)
Adafruit HUZZAH ESP8266
ESPresso Lite 1.0

ESPresso Lite 2.0

Phoenix 1.0

Phoenix 2.0

NodeMCU 0.9 (ESP-12 Module)

®  NodeMCU 1.0 (ESP-12E Module

6. Finally, re-open your Arduino IDE to ensure that it launches with the

new boards installed
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Blinking an LED with Arduino IDE

In this section, you're going to design a simple circuit to blink an LED with
the ESP8266 using Arduino IDE.

Why do we always blink an LED first? That’s a great question! If you can
blink an LED you can pretty much say that you can turn any electronic device

on or off.

Writing Your Arduino Sketch

The sketch for blinking an LED is very simple. You can find it in the link

below:

SOURCE CODE

https://qist.github.com/RuiSantosdotme/789861277da9680e9cfb

int pin = 2;

void setup() {
// initialize GPIO 2 as an output
pinMode (pin, OUTPUT) ;

// the loop function runs over and over again forever

void loop () {

digitalWrite (pin, HIGH) ; // turn the LED on (HIGH is the voltage level)
delay (1000) ; // wait for a second
digitalWrite (pin, LOW); // turn the LED off by making the voltage LOW
delay (1000) ; // wait for a second
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Uploading Code to ESP8266

Upload code to your ESP-12E NodeMCU Kit is very simple, since it has

built-in programmer. You plug your board to your computer and you don’t

need to make any additional connections.

Look at the Tools menu, select Board “NodeMCU 1.0 (ESP-12E Module)”
and all the configurations, by default, should look like this:

'ﬁ' sketch_dec2% | Arduine 1.6.13
File Edit Sketch Tools Help

sketch_dec29

vold setu

// put

vold

// put

loop

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Plotter
WiFi101 Firmware Updater

Board: "ModeMCU 1.0 (ESP-12E Module)”
CPU Frequency: "80 MHz"

Flash Size: "4M (3M SPIFFS)"

Upload Speed: "115200"

Port: "COME"

Get Board Info

Programmer: "AVRISP mkl"

Burn Bootloader

Ctrl+T

Ctrl+Shift+ M
Ctrl+5hift+L
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Important: your COM port is very likely to be different from the preceding
screenshot (Port: “COMG6”). That’s fine, because it doesn’t interfere with
anything. On the other hand, all the other configurations should look exactly

like mine.

After checking the configurations, click the “Upload Button” in the
Arduino IDE and wait a few seconds until you see the message “Done

uploading.” in the bottom left corner.

ek ek

Upload Button

Rui Santos

Complete project details at http://randomnerdtutorials.com

*********;"

int pin = 0;

woid setup{) {
S/ initialize GPIO 0 a3 an output.
pinMode {pin, OUTEUT):

}

[/ the leop functicn runs owver and over again forever

wold loop() {
digitalWrite (pin, HIGH): // turn the LED on (HIGH is the woltage level)
delay {1000} ; // wait for a second
digitalWrite (pin, LOW): // turn the LED off by making the woltage LOW
delay {1000} ; // wait for a second

t

—
~
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Final ESP-12E circuit

Connect an LED and a 220 Ohm resistor to your ESP8266 D4 (GPIO 2).

e

Powering the ESP8266|
through the USB connector

fritzing

Restart your ESP8266. Congratulations, you’ve made it! Your LED should be

blinking every 1 second!
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ESP8266 Web Server

This tutorial is a step-by-step guide that shows you how to build a standalone
ESP8266 Web Server that controls two outputs (two LEDs). You can then

replace those LEDs with any other electronics appliances.

@

192.168.1.132/5/00

£SP8266 Web Servel

GPI0 5- State on

e

P10 4-State off

This ESP8266 Web Server is mobile responsive and it can be accessed with
any device that as a browser in your local network. The code for this project

is done using Arduino IDE.

Watch the video tutorial

This project is available in video format on YouTube, just click on the link

below:

e https://voutu.be/dWM4gp KaTHY
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Prepare the Arduino IDE

1. Download and install the Arduino IDE on your operating system (some

older versions won’t work).

2, Then, you need to install the ESP8266 add-on for the Arduino IDE. For

that, go to File » Preferences.

3. Enter the following URL in the Additional Board Manager field:

http://arduino.esp8266.com/stable/package esp8266com index.json

Then, click the OK button.

Preferences x

Settings  Network

Sketchbook location:

C:\Jsers\Sara\Documents\Arduino Browse
Editor language: System Default w | (requires restart of Arduino)

Editor font size: 12

Interface scale: Automatic | 100 - %  (requires restart of Arduino)

Show verbose output during: compilation upload
Compiler warnings: All -

[] pisplay line numbers

[[] Enable Code Folding

Verify code after upload

[ Use external editor

Aggressively cache compiled core

Check for updates on startup

Update sketch files to new extension on save (.pde -> .ino)

Save when verifying or uploading

Nl LGy B NN E N A L E T S STt farduino esp8 266, com/fstable jpackage _esp8266com_index.json ﬁ

More preferences can be edited directly in the file

C:\Users\Sara'AppDatall ocal\Arduino 15preferences. tut

(edit only when Arduino is not running)

oK Cancel

LATEST PROJECTS - DOWNLOAD MORE RNT PRODUCTS — HOME AUTOMATION USING ESP8266

15



http://randomnerdtutorials.com/
http://randomnerdtutorials.com/products
https://randomnerdtutorials.com/home-automation-using-esp8266/
https://www.arduino.cc/en/Main/Software

4. Go to Tools » Board » Boards Manager...

sketch_aug22a | Arduino 1.6.5 - O X
File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch
sketch_augza Fix Encoding & Reload
vold setup() Serial Monitor Ctrl+Shift+M
/f put your
Board: "Arduine Uno" I Boards Manager... I
} Port Arduino AVR Boards
vold loop() | Programmer: "AVRISP mkll" : Arduine Ytin
/1 pur your Burn Bootloader ll Arduino Uno
, Arduino Duemilanove or Diecimila

5. Scroll down, select the ESP8266 board menu and install “esp8266

platform”, as shown in the figure below.

Boards Manager x
Type Al w | | Aiter your seardh.
~

Intel i686 Boards by Intel
Boards included in this package:
Edison.

More info

AMEL-Tech Boards by AMEL Technology
Boards included in this package:
SmartEverything Fox.

Online help

More info

esp8266 by ESP3266 Community
Boards included in this package:
Generic ESP8266 Module, Olimex MOD-WIFI-ESPB266(-DEV]), NodeMCU 0.9 (ESP-12 Maodule), NodeMCU 1.0 (ESP-12E Module), Adafruit HUZZAH

ESPB266 (ESP-12), SweetPea ESP-210.
o

Online help
More info
Close

6. Go to Tools » Board and select your ESP8266 board. Then, re-open
your Arduino IDE.
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Code

Copy the code below to your Arduino IDE, but don’t upload it yet. You need

to make some changes to make it work.

SOURCE CODE

https://qithub.com/RuiSantosdotme/Random-Nerd-

Tutorials/blob/master/Projects/ESP8266 Web Server Arduino IDE updated.ino

// Load Wi-Fi library
#include <ESP8266WiFi.h>

// Replace with your network credentials

const char* ssid "REPLACE WITH YOUR SSID";

const char* password = "REPLACE WITH YOUR PASSWORD";

// Set web server port number to 80

WiFiServer server (80);

// Variable to store the HTTP request

String header;

// Auxiliar variables to store the current output state

"Off";

String output5State
String output4State = "off";

// Assign output variables to GPIO pins
const int outputb = 5;

const int outputd = 4;

void setup () {
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Serial.begin (115200) ;

// Initialize the output variables as outputs
pinMode (output5, OUTPUT) ;

pinMode (output4, OUTPUT) ;

// Set outputs to LOW

digitalWrite (output5, LOW) ;

digitalWrite (output4, LOW) ;

// Connect to Wi-Fi network with SSID and password
Serial.print ("Connecting to ");
Serial.println(ssid);
WiFi.begin (ssid, password) ;
while (WiFi.status() != WL CONNECTED) {

delay (500) ;

Serial.print(".");
}

// Print local IP address and start web server

Serial.println("");
Serial.println("WiFi connected.");
Serial.println("IP address: ");

Serial.println(WiFi.localIP());

server.begin () ;

void loop () {

WiFiClient client = server.available(); // Listen for incoming clients
if (client) { // If a new client connects,
Serial.println("New Client."); // print a message out in the serial port
String currentLine = ""; // make a String to hold incoming data
while (client.connected()) { // loop while the client's connected
if (client.available()) { // if there's bytes to read
char ¢ = client.read(); // read a byte, then
Serial.write(c); // print it out the serial monitor

header += c;
if (¢ == "\n'") { // if the byte is a newline character
// 1f the current line is blank, you got two newline characters in a row.
// that's the end of the client HTTP request, so send a response:
if (currentLine.length() == 0) {
// HTTP headers always start with a response code (e.g. HTTP/1.1 200 OK)
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// and content-type so the client knows what's coming, then a blank line:
client.println ("HTTP/1.1 200 OK");
client.println("Content-type:text/html") ;
client.println ("Connection: close");

client.println () ;

// turns the GPIOs on and off

if (header.indexOf ("GET /5/on") >= 0) {
Serial.println("GPIO 5 on");
outputbState = "on";
digitalWrite (outputb, HIGH) ;

} else if (header.indexOf ("GET /5/0ff") >= 0) {
Serial.println ("GPIO 5 off");
outputbState = "off";
digitalWrite (outputb5, LOW) ;

} else if (header.indexOf ("GET /4/on") >= 0) {
Serial.println("GPIO 4 on");
output4State = "on";
digitalWrite (output4, HIGH) ;

} else if (header.indexOf ("GET /4/0off") >= 0) {
Serial.println("GPIO 4 off");
output4State = "off";
digitalWrite (output4, LOW) ;

// Display the HTML web page
client.println ("<!DOCTYPE html><html>") ;
client.println ("<head><meta name=\"viewport\"
content=\"width=device-width, initial-scale=1\">");
client.println("<link rel=\"icon\" href=\"data:,\">");
// CSS to style the on/off buttons
// Feel free to change the background-color and font-size attributes
client.println ("<style>html { font-family: Helvetica; display:
inline-block; margin: Opx auto; text-align: center;}");
client.println(".button { background-color: #195B6A; border:
none; color: white; padding: 1lé6px 40px;");
client.println ("text-decoration: none; font-size: 30px; margin:
2px; cursor: pointer;}");
client.println (".button2 {background-color:

#77878A; }</style></head>") ;
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// Web Page Heading
client.println ("<body><hl>ESP8266 Web Server</hl>");

// Display current state, and ON/OFF buttons for GPIO 5
client.println ("<p>GPIO 5 - State " + output5State + "</p>");
// If the output5State is off, it displays the ON button
if (outputbState=="off") ({
client.println("<p><a href=\"/5/on\"><button
class=\"button\">ON</button></a></p>") ;
} else {
client.println ("<p><a href=\"/5/off\"><button class=\"button
button2\">0FF</button></a></p>") ;
}

// Display current state, and ON/OFF buttons for GPIO 4
client.println ("<p>GPIO 4 - State " + output4State + "</p>");
// If the outputd4State is off, it displays the ON button
if (outputdState=="off") ({
client.println ("<p><a href=\"/4/on\"><button
class=\"button\">ON</button></a></p>") ;
} else {
client.println("<p><a href=\"/4/o0ff\"><button class=\"button
button2\">0FF</button></a></p>") ;

}
client.println ("</body></html>") ;

// The HTTP response ends with another blank line
client.println () ;
// Break out of the while loop
break;
} else { // if you got a newline, then clear currentLine

wn o,
’

currentLine =

}

} else if (¢ !'= '\r') { // if you got anything else but a carriage

return character,

currentLine += c; // add it to the end of the currentLine
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// Clear the header variable

header = "";

// Close the connection

client.stop() ;

Serial.println("Client disconnected.");

Serial.println(""):;

You need to modify the following two variables with your network credentials,

so that your ESP8266 can establish a connection with your router.

// Replace with your network credentials

const char* ssid "REPLACE WITH YOUR SSID";

const char* password = "REPLACE WITH YOUR PASSWORD";

Uploading the Sketch

Uploading the Sketch to the ESP-12E

If you're using an ESP-12E NodeMCU Kit, uploading the sketch is very
simple, since it has built-in programmer. Plug your board to your computer.

Make sure you have the right board and COM port selected.

Then, click the “Upload Button” in the Arduino IDE and wait a few seconds

until you see the message “Done uploading.” in the bottom left corner.
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% Web_Server | Arduina 1.8.5 - O *
File Edit Sketch Tools Help

Web_Server

S/ Load Wi-Fi library
$include <ESPEZ66WiFi.h>

f/ Beplace with your network credentials
conat char* ssid = "'-":
conat char® password = ™ "

[/ Set wek server port number to S0
WiFiServer serwver(80):

< >

Uploading Sketch to the ESP-01

Uploading code to the ESP-01 requires establishing a serial communication
between your ESP8266 and a FTDI Programmer as shown in the schematic

diagram below.

&
=
]
]
-
i

DTR RXI Txo

The following table shows the connections you need to make between the

ESP8266 and the FTDI programmer.
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ESP8266 FTDI programmer
RX TX

TX RX

CH_PD 3.3V

GPIO o GND

VCC 3.3V

GND GND

If you have a brand new FTDI Programmer and you need to install your FTDI

drivers on Windows PC, visit this website for the official drivers.

Alternatively, you can contact the seller that sold you the FTDI Programmer.

Then, you just need to connect the FTDI programmer to your computer, and
upload the code to the ESP8266.

Schematics

To build the circuit you need the following parts:

o ESP8266 12-E — read Best ESP8266 Wi-Fi Development Boards
e 2x LEDs

e 2x Resistors (220 or 330 ohms should work just fine)

e Breadboard

e Jumper wires

e If you're using ESP-01, you also need an FTDI programmer.

Connect two LEDs to your ESP8266 as shown in the following schematic

diagram — with one LED connected to GPIO 4, and another to GPIO 5.
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If you are using ESP-o1...

If you’re using the ESP8266-01, use the following schematic diagram as a
reference, but you need change the GPIOs assignment in the code (to GPIO
2 and GPIO o).

LATEST PROJECTS - DOWNLOAD MORE RNT PRODUCTS —- HOME AUTOMATION USING ESP8266 24



http://randomnerdtutorials.com/
http://randomnerdtutorials.com/products
https://randomnerdtutorials.com/home-automation-using-esp8266/
https://i0.wp.com/randomnerdtutorials.com/wp-content/uploads/2015/02/ESP-web-server_bb.png?ssl=1

Testing the Web Server

Now, you can upload the code, and it will work straight away. Don’t forget to

check if you have the right board and COM port selected, otherwise you’ll get
an error when trying to upload. Open the Serial Monitor at a baud rate of

115200.

Finding the ESP8266 IP Address

Press the ESP8266 RESET button, and it will output the ESP IP address on

the Serial Monitor

€ com3 - 0o X

Send

WiFi connected.
1P gddresas
192.1658.1.132

W
< >

Autoscrall BothML &CR -~ | |115200 baud - Clear output

Copy that IP address, because you need it to access the web server.

Accessing the Web Server

Open your browser, type the ESP IP address, and you’ll see the following
page. This page is sent by the ESP8266 when you make a request on the ESP
IP address.
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[ 192.168.1.132 X

& C | @ 192.168.1.132 * B ® :

ESP8266 Web Server

GPIO 5 - State off

GFIO 4 - State off

If you take a look at the Serial Monitor, you can see what’s going on on the
background. The ESP receives an HTTP request from a new client — in this
case, your browser. You can also see other information about the HTTP

request — these fields are called HTTP header fields, and they define the

operating parameters of an HTTP transaction.

&8 com3

Client disconnected.

Send

New Client.

GET / HTTE/1.1

Host: 192.1658.1.132

Connection: keep-aliwve

Cache-Control: max-age=0

User-Agent: Mozilla/5.0 (Windows NI 10.0; Wing4;
Upgrade-Insecure-Bequests: 1

Lcocept: text/html,application/xhtml+xml,application/xml;g=0.9,image/webp,image/apng, */*;g=0.8
LAccept-Encoding: gzip, deflate

Accept-Language: pt-FI,pt;g=0.9,en-U5;q=0.8,en;q=0.7

¥64) AppleWebKit/537.36 (KHIML, like Gecko) CI

Client disconnected.

HNew Clisnt.

€

Autoscroll Both ML &CR  ~ | |115200 baud ~- Clear output
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Testing the Web Server

Let’s test the web server. Click the button to turn GPIO 5 ON. The ESP
receives a request on the /5/on URL, and turns LED 5 ON.

€2 coms - O X

| Send

Client disconnected.

Mew Client.

GET /5/on HITE/1.1
Host: 192.168.1.132
Connection: keep-aliwve

Upgrade-Insecure-Requests: 1

User-Agent: Mozilla/5.0 (Windows NT 10.0; Winéd; xé4) AppleWebEit/537.36 (EHIML, like Gec
hccept: text/html,application/xhtml+xml,application/xml;qg=0.%,image/webp, image/apng, ¥/ %;¢
Referer: http://192.168.1.132/

hccept-Encoding: gzip, deflate

Loccept-Language: pt-PT,pti;g=0.9,en-US;g=0.3,en;q=0.7

GFIO 5 on

Client disconnected. v
4 >
Autoscrall Both NL &CR | | 115200baud -~ Clear output

The LED state is also updated on the web page.

192.168.1.132/5/on x
i

& C | @ 192.168.1.132/5/0n w B E

ESP8266 Web Server

aPI0 5

OFF

GPIO 4 - State off

Test GPIO 4 button and check that it works in a similar way.
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How the Code Works

Now, let’s take a closer look at the code to see how it works, so that you are

able to modify it to fulfill your needs.

The first thing you need to do is to include the ESP8266WiFi library.

// Load Wi-Fi library
#include <ESP8266WiFi.h>

As mentioned previously, you need to insert your SSID and password in the

following lines inside the double quotes.

// Replace with your network credentials
const char* ssid = "REPLACE WITH YOUR SSID";

const char* password = "REPLACE WITH YOUR PASSWORD";

Then, you set your web server to port 80.

// Set web server port number to 80

WiFiServer server (80);

The following line creates a variable to store the header of the HTTP request:

// Variable to store the HTTP request

String header;

Next, you create auxiliary variables to store the current state of your outputs.

If you want to add more outputs and save its state, you need to create more

variables.
String outputS5State = "off";
String output4d4State = "off";

You also need to assign a GPIO to each of your outputs. Here we are using
GPIO 5 and GPIO 4. You can use any other suitable GPIOs.
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const int outputb

const int outputd = 4;

setup()

Now, let’s go into the setup(). The setup() function only runs once when
your ESP first boots. First, we start a serial communication at a baud rate of

115200 for debugging purposes.

Serial.begin (115200) ;

You also define your GPIOs as OUTPUTs and set them to LOW.

pinMode (output5, OUTPUT) ;
pinMode (output4, OUTPUT) ;
// Set outputs to LOW
digitalWrite (outputb5, LOW) ;
digitalWrite (output4, LOW) ;

The following lines begin the Wi-Fi connection with WiFi.begin(ssid,
password), wait for a successful connection and prints the ESP IP address

in the Serial Monitor.

// Connect to Wi-Fi network with SSID and password
Serial.print ("Connecting to ");
Serial.println(ssid);
WiFi.begin (ssid, password) ;
while (WiFi.status() != WL CONNECTED) ({

delay (500) ;

Serial.print(".");
}
// Print local IP address and start web server
Serial.println("");
Serial.println("WiFi connected.");
Serial.println("IP address: ");

Serial.println(WiFi.localIP())
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server.begin () ;

loop()

In the loop() we program what happens when a new client establishes a

connection with the web server.

The ESP is always listening for incoming clients with this line:

WiFiClient client = server.available(); // Listen for incoming clients

When a request is received from a client, we’ll save the incoming data. The
while loop that follows will be running as long as the client stays connected.
We don’t recommend changing the following part of the code unless you

know exactly what you are doing.

if (client) { // If a new client connects,
Serial.println("New Client."); // print a message out in the serial port
String currentLine = ""; // make a String to hold incoming data
while (client.connected()) { // loop while the client's connected
if (client.available()) { // if there's bytes to read
char ¢ = client.read(); // read a byte, then
Serial.write(c); // print it out the serial monitor

header += c;
if (¢ == '\n'") { // 1f the byte is a newline character
// if the current line is blank, you got two newline characters in a row.
// that's the end of the client HTTP request, so send a response:
if (currentLine.length() == 0) {
// HTTP headers always start with a response code (e.g. HTTP/1.1 200 OK)
// and content-type so the client knows what's coming, then a blank line:
client.println ("HTTP/1.1 200 OK");
client.println("Content-type:text/html") ;
client.println ("Connection: close");

client.println () ;

The next section of if and else statements checks which button was pressed

in your web page, and controls the outputs accordingly.
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As we’ve seen previously, we make a request on different URLs depending

on the button we press.

// turns the GPIOs on and off

if (header.indexOf ("GET /5/on") >= 0) {
Serial.println ("GPIO 5 on");
outputb5State = "on";
digitalWrite (output5, HIGH) ;

} else if (header.indexOf ("GET /5/0off") >= 0) {
Serial.println("GPIO 5 off");
outputbState = "off";
digitalWrite (outputb, LOW) ;

} else if (header.indexOf ("GET /4/on") >= 0) {
Serial.println("GPIO 4 on");
output4State = "on";
digitalWrite (outputé4, HIGH) ;

} else if (header.indexOf ("GET /4/off") >= 0) {
Serial.println("GPIO 4 off");
outputd4State = "off";
digitalWrite (output4, LOW) ;

}

For example, if you've pressed the GPIO 5 ON button, the URL changes to
the ESP IP address followed by /5/0ON, and we receive that information on
the HTTP header. So, we can check if the header contains the expression
GET /5/on.

If it contains, the code prints a message on the serial monitor, changes

the outputsState variable to on, and turns the LED on.

This works similarly for the other buttons. So, if you want to add more

outputs, you should modify this part of the code to include them.
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Displaying the HTML Web Page

The next thing you need to do, is generate the web page. The ESP8266 will
be sending a response to your browser with some HTML text to display the

web page.

The web page is sent to the client using the client.println() function. You

should enter what you want to send to the client as an argument.

The first text you should always send is the following line that indicates that

we’re sending HTML.

<!DOCTYPE html><html>

Then, the following line makes the web page responsive in any web browser.

client.println ("<head><meta name=\"viewport\" content=\"width=device-width,

initial-scale=1\">");

The next one is used to prevent requests related to the favicon — You don’t

need to worry about this line.

client.println("<link rel=\"icon\" href=\"data:,\">");

Styling the Web Page

Next, we have some CSS to style the buttons and the web page appearance.
We choose the Helvetica font, define the content to be displayed as a block

and aligned at the center.

client.println("<style>html { font-family: Helvetica; display: inline-block;

margin: Opx auto; text-align: center;}");

We style our buttons with the some properties to define color, size, border ...
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client.println(".button { background-color: #195B6A; border: none; color:
white; padding: 16px 40px;");

client.println ("text-decoration: none; font-size: 30px; margin: 2px; cCursor:
pointer;}");

Then, we define the style for a second button, with all the properties of the
button we’ve defined earlier, but with a different color. This will be the style

for the off button.

client.println(".button2 {background-color: #77878A;}</style></head>");

Setting the Web Page First Heading

In the next line you set the first heading of your web page, you can change

this text to whatever you like.

client.println ("<body><hl>ESP8266 Web Server</hl>");

Displaying the Buttons and Corresponding State

Then, you write a paragraph to display the GPIO 5 current state. As you can
see we use the outputsState variable, so that the state updates instantly

when this variable changes.

client.println ("<p>GPIO 5 - State " + outputbState + "</p>");

Then, we display the on or the off button, depending on the current state of
the GPIO.

if (outputbState=="off") ({

client.println ("<p><a href=\"/5/on\"><button class=\"button\">ON</button></a></p>") ;
} else {

client.println("<p><a href=\"/5/0ff\"><button class=\"button
button2\">0FF</button></a></p>") ;
}
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We use the same procedure for GPIO 4.

// Display current state, and ON/OFF buttons for GPIO 4
client.println ("<p>GPIO 4 - State " + output4dState + "</p>");
// If the outputd4State is off, it displays the ON button
if (outputdState=="off") {
client.println ("<p><a href=\"/4/on\"><button class=\"button\">ON</button></a></p>") ;

} else {

client.println ("<p><a href=\"/4/o0ff\"><button class=\"button button2\">OFF</button></a></p>");

Closing the Connection

Finally, when the response ends, we clear the header variable, and stop the

connection with the client with client.stop().

// Clear the header variable
header = "";
// Close the connection

client.stop() ;

Taking it Further

Now that you know how the code works, you can modify the code to add more

outputs, or modify your web page. To modify your web page you may need
to know some HTML and CSS basics. Instead of controlling two LEDs, you

can control a relay to control practically any electronics appliances.

If you like ESP8266 make sure you check our course about Home

Automation with the ESP8266.
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